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Target Audience: 

 Accountant/Bookkeeper  Producer 

X CSR  Trainer 

 Carrier  Vendor 

X IT Manager/Systems Coordinator  ALL 

X Operations  Other:  (describe) 

 Principal/Owner   

 
Seminar Type:  Microsoft Products, Reports  
Seminar Level:  Advanced:  An advanced level course facilitates the development of thoughts 
(ideas, theories, procedures) to the most advanced stage possible. For functional courses, the 
objectives taught at this level challenge learners to analyze and make business decisions on how to 
utilize the agency management system or software in their agency, or apply a high level of technical 
aptitude to understand in depth features and functionality. 
 
Class Description:  In this very advanced session, you will discover how to work with 
headers/footers, section breaks, pull from multiple applications, insert various objects, work with 
tables and math functions, macros, drawing objects, linking and embedding, and more.  You will 
need a good working knowledge of Word to take your formletters and proposals to this next level as 
this session will move quickly. 
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Learning Outcomes:  

 Discover how to insert pictures and link to other documents in proposals. 

 Identify how to use Word’s math functions to automatically total an equipment schedule or a 
premium summary, as well as the possibilities and limitations for pulling data from multiple 
applications into a single page. 

 Demonstrate the knowledge you need to make your proposals more professional and easier 
for your CSRs/Account Managers to create. 

 
Assumptions:  This seminar is based on the following 

TAM Version 12 
Microsoft ® Word Version 2007/2010 
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Section Breaks 

When TAM/Vision creates a proposal on the client or prospect, it does it by creating each 
individual page from the master documents in the proposal setup, then merging them all 
into a single document. Between each page TAM/Vision puts a Section Break – you can see 
them by turning Formatting Marks on (the ¶ symbol on the toolbar). 
 

 
 
 

Section Breaks come in various types; the most common, and the one that we are interested 
in here, is a Section Break-Next Page. It forces a new page at that point in the document. 

Turns formatting 
marks on 

Section Break 

inserted when 

TAM creates 

proposal 
 



 
 SESSION HANDOUT 

 Advanced Techniques for Formletters and Proposals 

Advanced Techniques for Formletters and Proposals //  PAGE  5 

 

Applied Client Network  |  www.appliedclientnetwork.org 

 

Whenever a section break occurs you can change the page-based formatting – the margins; 
the page layout (landscape/portrait); the printer bin selection; and the headers and footers, 
which usually include the page numbering. This makes Section Breaks a very powerful and 
useful tool – here are just a few examples of how you can make use of them: 
 
You can print one page of the proposal from your printer's letterhead bin, and the rest from 
the plain paper bin 

 

You can print one page (or more) in landscape mode – perhaps a schedule, or an inserted 
Excel spreadsheet – with the rest of the document in portrait mode 

You can set up headers and footers that change throughout the document – perhaps one 
section is headed "Coverages and Limits" while another is headed "Coverage Descriptions" 

You can have page numbers print on certain pages, but not all – perhaps not on the cover 
page, or on the cover letter 

 
It is important when editing a proposal that has been created at the client/prospect that you 
do not inadvertently delete a Section Break. If you do, your proposal will change in 
unexpected ways – any of the features mentioned above might suddenly not be set the way 
you expect them.  
 
By default the type of Section Break that the TAM/Vision/Word interface uses is Section 
Break – Next Page. There is another option – Section Breaks - Continuous. If you use this 
then the various proposal sections will appear on the same page. This can be useful for 
coverage pages that have very little information and 
don’t take up much space on a page. To change the 
Section break type, in the master document you want 
it changed on (the one that will have the next “page’ 
printed after it) go to Page Layout tab, Page Setup 
group click the dialog launcher, Layout, Section start, 
Continuous. If you want it changed back to New page 
at a later point in the proposal, go to that master 
document and make sure it’s set to New Page. 
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Headers and Footers 

You can have each section of your proposal have a different header – the most common use 
of this technique it to head each document with the name of the coverage part it is detailing 
– “Property”, Liability”, etc. You can also use the header &/or the footer to include your 
agency name or logo, page numbering, or other information. A version 10 enhancement 
enables you to directly put TAM data (e.g. the client name) into a header or footer. Headers 
and Footers are accessed from the Insert tab. 

 

Page Numbering 

Even though each proposal you create at the client/prospect level will be different, you can 
set up page numbering so that every proposal will be numbered correctly. You do this by 
putting the page number field in the footer of each individual proposal document. 
 
You probably have a proposal cover page that you do not want to be numbered and do not 
want included in the number count. So do not follow these steps for that page. In each of 
the other documents, follow these steps: 
 

Select Footer in the Insert tab, and then select Edit Footer.  

 

Insert the page numbering info you want by selecting Page Number, 
select Bottom of Page and the layout of where you want the number to 
be. Once it has been placed, then simply type “Page ” in front of it. 
 

 

Click on Page Number and select Format Page 
Numbers; you’ll get this screen: 
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On all the documents except possibly the first one in your Proposal Setup, you 
will select the button “Continue from previous section”. 

 

Close out of the Header & Footer. 
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Printer Bin Selection 

In theory you can set up the printer bin selection in the master documents – in each 
document go to your Page Setup, and pick the bin you want that page to print from. (Make 
sure you have selected the printer that your end users will be printing to, which may be 
different from the one you use at your workstation.) However there is currently a bug in the 
TAM/Word interface that sometimes stops these printer bin selections from holding when 
the proposal is created by the end user. Until that bug is fixed, here’s the workaround for 
the end user. 
 
The first suggestion is to make the cover letter – that will be printed on letterhead – the very 
first page of the proposal, even if you want it as the second page (behind a cover page) 
when you deliver the proposal. Do this in Document Setup/Proposal Setup by making the 
cover letter the top item in the list of documents included in the proposal. After the 
proposal has been created and printed for the client or prospect, it is easy to insert the 
printed page into its correct location in the paper stack. 
 

 
 

Office Icon (2007) or File tab (2010), Print, Page Setup, Paper tab. 

Choose the Paper Source for the first page (your letterhead bin) and for all the other pages 
(your plain paper bin). 

Change the setting in “Apply to” so that it is for the entire document. 

 

Cover letter (to 

be printed on 

letterhead) is the 

first item in the 

Proposal Setup 
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This fix can be written into a macro, which can be added to each user's toolbar, making it as 
simple as a single mouse click to fix the printer bins. See the macro section on page 19 for 
instructions on how to do this. 

Pulling Data From Multiple Applications 

It has always been a limitation of the interface that a single document (proposal master or 
formletter) can only be linked to one application type – business auto, property, etc. There is 
a way to get around this in certain circumstances. If you create a file called multiapp.flg (a 
blank text file – use Notepad to create it) in your TAM_EXE folder, you can set up a 
document to pull from two (or more) applications as long as they are on the same policy. To 
create the master, first link it with one of the apps you want to pull coverage from and insert 
all the fields etc you want from that app. Then change the Associated Application at the 
setup screen to the next app you want to pull data from, and insert all those fields. You can 
use Replicate tables but you cannot mix data from different apps in the same table. So you 
cannot, for instance, pull the location descriptions from the Application Information app and 
the Subjects of Insurance from the Property app and mix them into the same schedule. 

For the first page, 

pick the tray that 

holds letterhead 

paper 

For the rest of the 

document, pick 

the tray that holds 

plain paper 

Change “Apply 

to” to “Whole 

document” 
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Inserting Pictures  

It is very easy to insert pictures into any document.  
 
Before doing so, check a setting in Office Icon (2007) or File tab (2010), Advanced, Show 
document content – make sure “Show picture placeholders” is unchecked. 
 

 
 

You can now insert a picture in your document: 
 
Put your cursor at the place in the document where you want the picture inserted. 

On the Insert tab select either Picture or Clip Art. Locate and select the picture you wish to 
insert or search for the Clip Art topic. 
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When the picture appears in your document, you can right-click on it and make any changes 
you want to its size, location, etc. 

 

Inserting Pictures in IF Statements 

You can insert a picture into an IF statement by putting the cursor in the correct place in the 
IF statement – in either the "if true" section or the "if false" section – before you insert the 
picture. For instance, perhaps you have 2 agency logos and you want to use logo #1 for 
Agency #1 and logo #2 for Agency #2. Create an IF statement that tests if the Agency 
datafield is equal to 1; between the double quotes of the "if true" section insert logo#1, and 
between the double quotes of the "if false" section insert logo#2.  
 

 
 

Format the pictures to be the size and location you want. In the master document the 
pictures won't seem to be in the IF statement – they'll appear on the page based on the 
formatting you apply, and may in fact overlap each other, but when you run the proposal 
they'll show up correctly. 

Inserting Pictures in Header and Footer 

Another useful picture to insert is your agency letterhead for when you want to fax a letter – 
many people think they have to print the letter on letterhead then fax it manually, because if 
you just send the document to fax@vantage it will be sent as if it was on plain paper.  
 
Scan your letterhead in (just save the portion of the page with your logo, etc on it). 

Write a macro that inserts the letterhead image file into the header of your document. 

Put the "letterhead" macro on the Quick Access toolbar for easy, one-click operation. 

Use the fax macro to fax it without printing it! Two mouse clicks – one to insert the 
letterhead and one to fax it – is all it takes. 

Drawing Lines 

There are several ways to draw lines in documents, and some work better than others, 
depending on the circumstances. 

In the IF statement, put your Agency 

Two logo in the “If False” section 

In the IF statement, put your Agency 

One logo in the “If True” section 
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Underscore 

The first, and easiest, is the underscore character. Just repeatedly type as many in a row as 
you want (to get a line completely across the page, type 3 underscore characters followed 
by Enter). To get a double line, use the = character instead of the underscore  
 

character. The problem with this method is when you are creating a line on a form (e.g. a 
company app) on which the end user will be entering information. Because the underscore 
character is a typed character, the information will "push" the line aside instead of 
appearing on the line. 

Underline 

The second method is using Underline formatting, which can be useful when inserting 
datafields.  If you set up the datafield in the master document as underlined, then the data 
will be underlined in the final document. The underlining will be as long, or as short, as the 
data itself. 

Shapes Tools 

The third method is to use the shapes tool to draw lines in your master document. These 
lines are independent of the text and will remain in the same place, and the same length, no 
matter what data is inserted. You can find Shapes on the Insert tab. 
 
 
 
 
 
 
 
 

 Click on this icon, then put your cursor where you want the line to start, hold down 
the left button, and drag to where you want the line to end.  

 Here are a couple of tips to assist: to get an exactly horizontal line – no guesswork 
needed – hold down the Shift key while dragging. To get a line that extends equally in 
both directions from your starting point, hold down the Ctrl key while dragging. 

 Once you've inserted the line you probably won't be happy with exactly where it is or 
where it starts or ends. You can edit without starting over. Select the line by hovering 
the cursor over it till it turns into a four-way arrow, and left-clicking – the line will now 
have small circles at each end, meaning it has been selected. It will look like this:  

 

 You can put your cursor at either end and drag the end to lengthen or shorten it. You 
can also move the line on the page by dragging it with the mouse or by using the 
arrow keys (no mouse involvement here). If you press an arrow key the line will move 



 
 SESSION HANDOUT 

 Advanced Techniques for Formletters and Proposals 

Advanced Techniques for Formletters and Proposals //  PAGE  13 

 

Applied Client Network  |  www.appliedclientnetwork.org 

 

a certain amount in that direction; if you hold down the Ctrl key while pressing the 
arrow key, the line will move in much smaller increments – useful for placing a line 
exactly below where you want some text to be inserted. You can also copy a line by 
selecting it then holding down the Ctrl key while dragging the line to the second 
location (this is the standard Windows copy function). 

 

Table Borders 

Yet another way to insert lines in a document is using tables. By selectively turning on cell 
borders in a table you can create the appearance of individual lines while maintaining the 
constraints on the relative positions of information that the table provides. 

Borders 

Word can add both Page Borders and Paragraph borders to a document. Unfortunately 
Page Borders don’t work in the TAM/Word interface, so you can’t use them. You can “fake” 
them by selecting all the text on a page and put a paragraph border round it; you could also 
create a box graphic that is page-sized and insert it in the header for the page you want it 
on. (Make sure to change the header for subsequent pages if you don’t want the border on 
them too.) 

SET Command 

The SET command assigns a value to a reference name (also called Bookmarks in Word), 
which can then be used repeatedly throughout the document, though unfortunately the 
value does not “hold” across the various pages of a proposal as it is created. There are 
several ways this command can be used: 

 To include non-replicated data in a replicate table, or schedule. For instance if you 
want to pull the liability limit into the vehicle schedule on Business Auto. The 
command format would be {SET autoliability 
“<APP.BA2.COMBINED_SINGLE_LIMIT>”}. Then, wherever you want the liability 
limit to print, use the REF command – {REF autoliability}. 

 To pre-assign a default value to a reference that you are using in an ASK 
statement so that if the end user leaves the answer blank any IF statements 
relying on that answer will not error out. 

 To take non-standard answers to ASK statements and correct them to what you 
are looking for. For instance, you might have an ASK statement such as {ASK 
pollution “Do you want to include pollution coverage? Answer Y or N”} Then you 
have an IF statement that tests that bookmark and if it’s Y inserts the pollution 
coverage verbiage. But the end user might put in a lowercase y, and if he/she 
does, the IF statement will test as false. One way to address that is to always ask 
for numeric answers (1=Yes, 2=No). However if you haven’t done that you can 
nest the IF statement so it tests for both Y and y, but it’s quicker and easier, right 
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after the ASK statement, to put the following IF/SET combination: 
{IF pollution = “y” “{SET pollution “Y”} } 
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Math functions 

Although not as powerful or as varied as Excel, there are some basic math functions 

available within Tables in Word.   
 
Tables have cell references just like Excel EXCEPT you do not see the Column and Row labels.  
In the example shown below, the cell reference is displayed in each cell: 
 

A1 B1 C1 D1 

A2 B2 C2 D2 

A3 B3 C3 D3 

Accessing the Math Functions 

Place your cursor in the cell where you want the formula results to display. 
Click on Table Tools, Layout, Formula.  

 

If there are numbers displayed in the cells 
above or to the left of the selected cell, an 
automated formula (=Sum(Above)) or 
(=Sum(Left)) is shown. 
 
If neither of these is the desired formula, 
delete the automated formula leaving just 
the equal (=) sign in the brackets.  You can 
then enter the formula you need based on the available functions, by themselves or in 
various combinations.  Examples of the available functions are shown below: 
 

Add – "+" 
 

Add a number to a cell: =(A1)+3 

Add two adjacent cells: =SUM (A1:A2) or =(A1+A2) 

Add two non-adjacent cells: =(A1+A3) or =(A1)+(A3) 

Add a range of cells: =SUM(B1:B3) 

  
Subtract – "-" 
 

Subtract a number from a cell: =(A1)-1 

Subtract two cells: =(A3-B2) 

  
Multiply – "*" 
 

Multiply a cell by a number: =(A1)*3 

Multiply two adjacent cells: =PRODUCT(A1:A2) 
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Multiply two non-adjacent cells:  =(B1*B3) or =PRODUCT(B1)*(B3) 
 

  
Divide – "/" 
 

Divide a cell by a number: =(C2)/3 

Divide two cells: =(C2)/(A1) 

 
You can manually type the above functions into the formula field or select the function from 
the Paste Function box.  For instance, to add numbers, click SUM. 

 
 

To reference cells in formulas, use a comma to 
separate references to individual cells (ie, 
(=SUM(A1,B3) and a colon to separate the first and 
last cells in a designated range (ie, (=SUM(A1:D1). 
You can reference an entire row or column in a 
calculation in the following ways: 
 
Use a range that includes only the letter or number 
that represents it — for example, 1:1 to reference 
the first row in the table. This designation allows 

the calculation to automatically include all the cells in the row if you decide to add other cells 
later.  
 
Use a range that includes the specific cells — for example, a1:a3 to reference a column with 
three rows. This designation allows the calculation to include only those particular cells. If 
you add other cells later and you want the calculation to include them, you need to edit the 
calculation.  
 
You can format the results of your formula by selecting the format from the available 
options in the Number format box. For example, to display the numbers as a decimal 
percentage, click 0.00%.  
 

Notes:  
Word inserts the result of the calculation as a field in the cell you selected and does not 
automatically update the formula results if there are changes to the referenced cells. You 
can update the calculation by clicking once on the field (or selecting the entire table) and 
then pressing F9. 
 
If you see codes between braces instead of the actual sum (for example, {=SUM(LEFT)} not 
the number result you wanted), press SHIFT+F9 or ALT+F9 to switch to the number result. 
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If your column or row contains blank cells, Word will not total the entire column or row. To 
total the entire row or column, type a zero in each blank cell.  

Totaling Columns of Information in a Replicate Table 

Here we use math functions in a table that is replicated schedule information to provide a 
total once the document/proposal merges the client data: 
 
Formula looks like this: 

 
End result is this: 
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Performing Calculations on Data from TAM or ASK Statements 

This second example shows how the sum and multiply functions are used to add the results 
of ASK variables and then multiply that sum by various factors to obtain the applicable tax 
and fees: 
Formulas Look Like This: 

 
End Result is This: 
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Macros 

Many people are scared of macros and don't use them. This is a shame because they can 
make life very easy for the end user – and they are simple to set up. All you do to record a 
macro is switch on recording, then perform the steps you would perform anyway to achieve 
the result you want. When you've finished, you hit the "Stop Recording" button. It's as easy 
as that! You can then take that macro and put it on a button so a single mouse click will 
execute every step of the macro, and with a little more work you can make the macro 
available to every user in your agency. 
 
The easiest way to get all the steps right is to actually have a document that needs the 
actions performed on it. For example, to have page 1 pull from the letterhead bin and all the 
other pages pull from the plain paper bin, start by creating a proposal on a client, then 
switch on macro recording before fixing the document. 

Recording 

Developer (if this is not an available ribbon, right click on any ribbon and select 
Customize the Ribbon, then check Developer), Record Macro. 

 
 

Give the macro a name, for 
instance, FixPaperBins. 
(Please note there can be no 
spaces in the name) and click 
OK.  

Now carefully work though 
the steps to create your 
macro/procedure. Be careful 
with your workflow since all 
of your menu actions will be 
recorded and implemented by 
the saved macro 

Open up the Page Setup box 
and change the Paper Sources. 

Click on the Stop Recording button. 
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Assigning to Ribbon 

Right-click anywhere on the ribbon, select Customize the Ribbon. 

On the Choose Commands from, select Macros. 

Select the macro of your choice. Click the Tab name where you want to put it and 
select New Group. Then click Add. 

Right-click on the Macro name and Rename it. This is what will display on the screen 
and can have spaces in it – the longer you make the name the more space the icon 
will take up on your ribbon. You can also rename the New Group. 

Close the dialog box. 

Now test the macro by creating another proposal that needs fixing (remember you 
already fixed the one you have open on your screen when you recorded the macro, 
so you need to close that one). If you find it doesn't do what you expect, the easiest 
way to fix it for most macros that only have a few steps in them is to simply re-record 
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the macro – when you give the new macro the same name it will ask you if you want 
to replace the existing one – answer Yes. 

 

Copying to Other Workstations 

Macros are stored in the normal.dotm file, so the easiest way is to copy that file from your 
workstation out to a network drive (use File, Options, Advanced, General, File Locations to 
see where template files are stored) and then copy it in to each workstation you want it on. 
Be aware that this will copy ALL the settings in the normal.dotm file, so it will overwrite any 
toolbar changes etc that have already been made on the target workstation. 

 
 

Table of Contents 

You cannot set up a Table of Contents (TOC) in the master, but if you set up all your heading 
styles correctly you can have the end user add one to the final proposal fairly easily. The TOC 
entries are based on header styles, so make sure that in every one of your master 
documents you use the same style names for each of the headers you want at the same 
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level or sublevel in the TOC. In one of the master documents, where you want the TOC to 
appear, set up a blank page with the appropriate title (presumably “Table of Contents”).  
 
After the end user has created the proposal, he/she goes to References, Table of Contents, 
and select the style. The table will be created. It may be necessary to do some formatting for 
fonts, etc. 

Linking to & Embedding Documents, Spreadsheets, Charts 

Microsoft gives you the ability to combine data from two or more programs into one 
document.   This integration can occur by copying and pasting data between programs.  
Information or objects can also be copied and pasted between programs.  The downside to 
this is that if you continually update a spreadsheet that you have copied into another 
document, you will have to copy and paste the edited worksheet each time a change is 
made.  The reason for this is because the changes you make to the Excel worksheet are not 
reflected in your copied worksheet or document.   The program where your object was 
created is called your source.  The program where you want the object is called your 
destination. 
 
There are two different options to help you overcome the downside of copying and pasting 
objects between various programs.  What you will do is share the information with another 
program.  For example, you create a worksheet in Excel and then share it with another 
program such as Word.  This type of sharing is referred to as object linking and embedding 
(OLE).  You can create a linked object or an embedded object from any program that 
supports linked objects and embedded objects.   So, what does this mean?  First we need to 
understand the difference between a linked object and an embedded object.   
 
When you link an object, the object exists in the source program.  In the destination 
program, the object contains only a code that points to the name and location of the source.  
When you embed an object, it exists in both the source and the destination programs.   The 
thing to remember is that if you link an object, and you update the object in either the 
source or the destination, the other will reflect your changes.  If you embed an object and 
you change that object, those updates will not be reflected in the other program. 
 
So, should you link or embed your objects?  This will depend on how the information in the 
object is to be used.  For example, if you have an Excel worksheet that you want to insert 
into a Word document and it contains information that you don’t need to update, then the 
best thing here would be to either embed the object or simply copy and paste it.  If the 
worksheet that you want to copy will be continually updated, and you want those updates 
to appear in the destination program, then you should link the object. 
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An additional point that you must remember if you are going to link the object is that it (the 
object) must in a location on the network that is accessible to every user who will use the 
document. If the document can’t find the link, the object won’t be there. 

Linking Objects 

Let’s create a new Linked Object.  As mentioned earlier, when you link an object there is only 
one object so changes made to that object will be reflected in the source as well as the 
destination.  For our example we are going to link an Excel worksheet to a Word document.   
 

First we need to make sure that both Excel and Word are open. 

Make sure that your active program is Excel and you have the workbook containing 
the worksheet you want to link open. 

Select the cells that you want to link to your Word document. 

Click the Copy button. 

Switch to Word to make it your active program and open the document where you 
want to insert the worksheet cells.  Make sure that your cursor is in the insertion 
point in the document. 

Click Home, Paste, then select Paste Special.  The Paste Special dialogue box will 
appear.  
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Within this dialogue box you first need to select the “As” field.  This is the type of 
object that you are pasting.  In our case we are pasting in a Microsoft Excel 
Worksheet Object. 

You also have the option to either Paste or Paste Link.  Keep in mind, simply pasting 
will not allow for any updates to happen.  If you want to make sure that changes 
made in the source are updated in the destination, you will need to select the radio 
button for Paste Link.  

Right click in the table to get Paste Options. If you are linking data from a worksheet, 
and you select Keep Source Formatting and Link to Excel option, the linked data will 
match the formatting in your Excel worksheet.  If, on the other hand, you select the 
Match Destination Table Style and Link to Excel option, the linked data will be 
formatted in the Word default table style.  

 

Linking Word Documents 

Linking doesn’t have to be between two different programs.  You can link documents within 
the same program.  For example you can have an object in a Word document and link that 
object to another Word document, or even several Word documents.  When you make a 
change to the object in the original document, the other document(s) will automatically 
update.  When linking objects between Word documents, your “As” selection would be 
Microsoft Word Document Object; make sure that you select the Paste link option rather than 
just Paste. 

Editing a Document with a Linked Object 

To edit a document that contains a linked object, edit the object in your source program.  
For example, if your source originated in an Excel worksheet, then you would make the 
change in Excel.  Any changes that you make in your Excel worksheet will be reflected in 
your Word document the next time you open your document.  If you want the change to be 
saved, don’t forget to save the worksheet. 

Embedding Objects 

Now let’s create a new embedded object.  First we need to click in the document where we 
want the embedded object located.  On the Insert tab, click on Object and then select the 
Create New tab.  In the Object type box, you need to select the type of object that you want 
to create.  You can display the embedded object as an icon if others are going to be viewing 
the document online.  To do this, you would select the Display as icon check box.  You also 
have the ability to insert an Excel worksheet as an embedded object by clicking Insert 
Microsoft Excel Worksheet. 
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For our example, let’s create a new embedded object using an existing Excel file.   
 

First we need to make sure that both Excel and Word are open. 

Now, we need to be on our Excel document and select the entire worksheet, a chart, 
or a range of cells and click Copy. 

Go back to your Word document and click 
where you want the information to appear.  
On the Home tab, you will click Paste, then 
click Paste Special.  In the “As” box, click the 
entry with the word “object” in its name, 
such as Microsoft Excel Worksheet Object.  
Then click OK. 

This will paste the cells that you highlighted 
in your Excel sheet into your Word 
document.  So, how is this different from 

simply using the Copy, Paste commands?  The big advantage of embedding an object rather 
than simply copying and pasting is that you can edit the object using the tools of the 
program or application that the object was created in.  

Editing a Document with an Embedded Object 

If you need to edit an object that has been embedded, you can do this in the destination 
program using the tools of the source program.  To do this, in your destination program, 
open the document with the embedded object.  Then simply double-click on the embedded 
object.  This will cause the tools that are used in the source program to display in your 
destination program. 

Linking Charts 

There are many different types of objects that you can link or embed.  Another example 
would be a chart.  To link a chart into a Word document or even a PowerPoint presentation, 
make sure that you have both programs open (Excel and Word, or Excel and PowerPoint).   
 

To link a chart you would do the following: 
 

Open Excel and then open Word. 

In your Excel worksheet, select the chart area and click the Copy button. 

In your Word document, position your cursor where you want the chart to be located 
and click Paste, Paste Special.  You will see the following dialogue box. 
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Your “As” 
selection should 
be Microsoft Excel 
Chart Object.   

Your radio button 
selection should 
be Paste Link. 

 
By linking the 
chart, whenever 
you update the 
source program, it 
will update your 
destination 
program. 

Embedding 
Charts 

To embed a chart, you would follow the same procedure above, but rather than selecting 
Paste Link you would select Paste. 
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Shapes 

Word includes a set of drawing and graphics capabilities that you can use to easily embellish 
your text and graphics with 3-D effects, shadow effects, textured and transparent fills. We 
already described Drawing Lines on page 11.  To use these tools select Insert, Shapes.  You 
can now also use SmartArt which can incorporate pictures. 

 
 

 

Look what you can do with 

SmartArt! 

 

This is a Cloud Callout, one of 

many default designs available 

in Shapes. 
 

Operations 

• Liability 

Location #1 

• Property 

2012 Eco-Car 

• Automobile 


